CHAPTER 2

Getting Started with CMS

This chapter provides these topics about the Cluster Management Suite (CMS) software:
» Features, page 2-2
» Front Panel View, page 2-4
- Topology View, page 2-13
« Menus and Toolbar, page 2-18
« Interaction Modes, page 2-28
» Wizards, page 2-28
= Online Help, page 2-29
» CMS Window Components, page 2-30
» Accessing CMS, page 2-32
« Verifying Your Changes, page 2-34
« Saving Your Changes, page 2-34
« Using Different Versions of CMS, page 2-35
» Where to Go Next, page 2-35

Note « For system requirements and for browser and Java plug-in configuration procedures, refer to the
rel ease notes (http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900xI/index.htm).

» For procedures for using CMS, refer to the online help.

Note  This chapter describes CM S on the Catalyst 2900 XL and Catalyst 3500 XL switches. Refer to the
appropriate switch documentation for descriptions of the web-based management software used on other
Catalyst switches.
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Features

CMS provides these features (Figure 2-1) for managing switch clusters and individual switches from
Web browsers such as Netscape Communicator or Microsoft Internet Explorer:

» Two views of your network that can be displayed at the same time:

— The Front Panel view displays the front-panel image of a specific switch or the front-panel
images of all switchesin a cluster. From this view, you can select multiple ports or multiple
switches and configure them with the same settings.

When CM Sis launched from a command switch, the Front Panel view displays the front-panel
images of all switchesin the cluster. When CMS is launched from a noncommand switch, the
Front Panel view displays only the front panel of the specific switch.

Note ~CMS from a standalone switch or from a noncommand switch is referred to as Device
Manager (also referred to as Switch Manager). Device Manager is for configuring an
individual switch. When you select Device Manager for a specific switch in the cluster, you
launch a separate CM S session. The Device Manager interface can vary between the Catalyst
switch platforms.

— TheTopology view displaysanetwork map that usesiconsthat represent switch clusters, cluster
members, cluster candidates, neighboring devices that are not eligible to join acluster, and link
types. From thisview, you can select multiple switches and configure them to run with the same
settings. You can also display link information in the form of link reports and link graphs.

Thisview is available only when CM S is launched from a command switch.
- Menus and toolbar to access configuration and management options:

— The menu bar provides the complete list of options for managing a single switch and switch
clusters.

— Thetoolbar provides buttons for commonly used switch and cluster configuration options and
information windows such as legends and online help.

— The port popup menu, in the Front Panel view, provides options specific for configuring and
monitoring switch ports.

— The device popup menu, in either the Front Panel or the Topology views, provides switch and
cluster configuration and monitoring options.

— The candidate, member, and link popup menus provide options for configuring and monitoring
devices and links in the Topology view.

The toolbar and popup menus provide quick ways to access frequently used menu-bar options.
» Toolsto simplify configuration tasks:

— Interactive modes—guide mode and expert mode—that control the presentation of some
complex configuration options

— Wizards that require minimal information from you to configure some complex features

— Comprehensive online help that provides high-level concepts and procedures for performing
tasks from the window

Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
m. 78-6511-09 |



| Chapter2 Getting Started with CMS
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» Two levels of access to the configuration options. read-write access for users allowed to change
switch settings; read-only access for users allowed to only view switch settings

- Consistent set of GUI components (such as tabs, buttons, drop-down lists, tables, and so on) for a
consistent approach to setting configuration parameters

Figure 2-1 CMS Features
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Front Panel View

When CMS is launched from a command switch, the Front Panel view displays the front-panel images
of all switchesin the cluster (Figure 2-2). When CMS is launched from a standal one or noncommand
member switch, the Front Panel view displays only the front panel of the specific switch (Figure 2-3).

Figure 2-2  Front Panel View from a Command Switch
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Front Panel View

The cluster tree (Figure 2-2) appearsin the left frame of the Front Panel view and shows the name of the
cluster and alist of its members. The sequence of the cluster-treeicons (Figure 2-4) mirror the sequence
of the front-panel images. You can change the sequence by selecting View > Arrange Front Panel. The
colors of the devices in the cluster tree show the status of the devices (Table 2-1).

If you want to configure switch or cluster settings on one or more switches, select the appropriate
front-panel images.

» To select afront-panel image, click either the cluster-tree icon or the corresponding front-panel
image. The front-panel image is then highlighted with a yellow outline.

» To select multiple front-panel images, pressthe Ctrl key, and left-click the cluster-tree icons or the
front-panel images. To deselect anicon or image, pressthe Ctrl key, and left-click theicon or image.

If the cluster has many switches, you might need to scroll down the window to display the rest of
front-panel images. Instead of scrolling, you can click an icon in the cluster tree, and CMS then scrolls
and displays the corresponding front-panel image.

Figure 2-4  Cluster-Tree Icons
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Table 2-1  Cluster Tree Icon Colors

Color Device Status

Green |Switch is operating normally.

Yellow |Theinternal fan of the switchisnot operating, or the switch isreceiving power from an RPS.

Red Switch is not powered up, has lost power, or the command switch is unable to communicate
with the member switch.
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Front-Panel Images

You can manage the switch from a remote station by using the front-panel images. The front-panel
images are updated based on the network polling interval that you set from CM S > Preferences.

This section includes descriptions of the LED images. Similar descriptions of the switch LEDs are
provided in the switch hardware installation guide.

Note  The Preferences window is not available if your switch access level is read-only. For more information
about the read-only access mode, see the “Access Modesin CMS” section on page 2-33.

Figure 2-5 shows the port icons as they appear in the front-panel images. To select a port, click the port

on the front-panel image. The port is then highlighted with a yellow outline. To select multiple ports,
you can:

» Presstheleft mouse button, drag the pointer over the group of portsthat you want to select, and then
release the mouse button.

» Pressthe Ctrl key, and click the ports that you want to select.
» Right-click a port, and select Select All Ports from the port popup menu.

Figure 2-5 Port Icons
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Table 2-2  Port Icon Colors for the CWDM GBIC Module Ports

Wavelength Color
1470 nanometers (nm) Gray
1490 nm Violet
1510 nm Blue
1530 nm Green
1550 nm Yellow
1570 nm Orange
1590 nm Red
1610 nm Brown
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Redundant Power System LED

The Redundant Power System (RPS) LED shows the RPS status (Table 2-3 and Table 2-4). Certain
switches in the switch cluster use a specific RPS model:

» Cisco RPS 300 (model PWR300-AC-RPS-N1)—Catalyst 2900 LRE XL, Catalyst 2950,
Catalyst 3524-PWR XL, and Catalyst 3550 switches

» Cisco RPS 600 (model PWR600-AC-RPS)—Catalyst 2900 XL and Catalyst 3500 XL switches,
except the Catalyst 2900 LRE XL and Catalyst 3524-PWR XL switches

Refer to the appropriate switch hardware documentation for RPS descriptions specific for the switch.

Table 2-3  Cisco RPS 300 LED on the Catalyst 2900 LRE XL, Catalyst 2950, Catalyst 3524-PWR XL, and Catalyst 3550
Switches

Color RPS Status

Black (off) RPS is off or is not installed.

Green RPS is connected and operational.

Blinking green |RPS is providing power to another switch in the stack.

Amber RPS is connected but not functioning.

The RPS could be in standby mode. To put the RPS in Active mode, press the Standby/A ctive button on the
RPS, and the LED should turn green. If it does not, one of these conditions could exist:

« One of the RPS power supplies could be down. Contact Cisco Systems.
- The RPS fan could have failed. Contact Cisco Systems.

Blinking amber

Internal power supply of the switch is down, and redundancy is lost. The switch is operating on the RPS.

Table 2-4

Cisco RPS 600 LED on the Catalyst 2900 XL and Catalyst 3500 XL Switches Except the Catalyst 2900 LRE XL,

and Catalyst 3524-PWR XL Switches

Color RPS Status

Black (off) RPS is off or is not installed.

Green RPS is operational.

Blinking green |RPS and the switch AC power supply are both powered up. If the switch power supply fails, the switch
powers down and after 15 seconds restarts, using power from the RPS. The switch goes through its normal
boot sequence when it restarts.

Note  Thisisnot a recommended configuration.

Amber RPS is connected but not functioning properly. One of the power supplies in the RPS could be powered

down, or afan on the RPS could have failed.
Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
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Port Modes and LEDs

The port modes (Table 2-6) determine the type of information displayed through the port LEDs. When
you change port modes, the meanings of the port LED colors (Table 2-7, Table 2-8, and Table 2-9) also
change.

Note  The bandwidth utilization mode (UTL LED) does not appear on the front-panel images. Select Reports
> Bandwidth Graphsto display the total bandwidth in use by the switch. Refer to the switch hardware
installation guide for information about using the UTL LED.

To select or change a mode, click the Mode button until the desired mode LED is green.

Table 2-6  Port Modes

Mode LED Description

STAT Ethernet link status of the 10/100, 100BASE-FX, or 1000BASE-X switch ports, or the Ethernet
link status on the remote customer premises equipment (CPE) device.
Default mode on all Catalyst 2900 XL and Catalyst 3500 XL switches except the
Catalyst 2900 LRE XL switches.

LRE Long-Reach Ethernet (LRE) link status of the LRE ports on the Catalyst 2900 LRE XL switches.

(Catalyst 2900 LRE XL
only)

Default mode on these switches only.

Note  When the LRE mode is active, the 10/100 switch ports on the Catalyst 2900 LRE XL
continue to show Ethernet link status.

FDUP or DUPLX

Duplex setting on the ports. Default settings are:
« 10/100 ports: Auto

e 100BASE-FX ports. Auto

- Gigabit ports: Auto

« LRE ports: Half-duplex

Note  Inthis mode on the Catalyst 2900 LRE XL switches, the LRE port LEDs show the duplex
mode used on the CPE Ethernet link between the remote CPE device and an Ethernet
device.

SPEED or SPD

Speed setting on the ports. Default setting is auto on the 10/100 ports.

Note  Inthis mode on the Catalyst 2900 LRE XL switches, the LRE port LEDs show the link
speed between the remote CPE device and an Ethernet device.

LINE PWR
(Catalyst 3524-PWR XL

only)

Inline power setting on the Catalyst 3524-PWR XL 10/100 ports. Default setting is auto.

i Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
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Table 2-7  Port LEDs on the Catalyst 2912, 2924C, 2924, 2912MF, and 2924M XL Switches !
Port Mode |Port LED Color |Description
STAT Cyan (off) No link.
Green Link present, and port isin STP forwarding state.
Amber Link fault. Error frames can affect connectivity, and errors such as excessive collisions, CRC
errors, and alignment and jabber errors are monitored for a link-fault indication.
Port is not forwarding. Port was disabled by management, or by an address violation, or was
blocked by Spanning Tree Protocol (STP).
Note  After aport isreconfigured, the port LED can remain amber for up to 30 seconds as
STP checks the switch for possible loops.
Brown No link and port is administratively shut down.
FDUP Cyan (off) Port is operating in half-duplex mode.
Green Port is operating in full-duplex mode.
SPD 10/100 Ports
Cyan (off) Port is operating at 10 Mbps.
Green Port is operating at 100 Mbps.
100BASE-FX Ports
Cyan (off) Port is not operating.
Green Port is operating at 100 Mbps.
ATM Ports
Cyan (off) Port is not operating.
Green Port is operating at 155 Mbps.
Gigabit Ports
Cyan (off) Port is not operating.
Green Port is operating at 1000 Mbps.

1. Onthe modular switches, port LED 1 or 2 is green when amodule is installed. Refer to the module documentation for complete information.
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Table 2-8  LRE Port LEDs on the Catalyst 2900 LRE XL Switches *
Port Mode |Port LED Color Description
LRE Note  InLRE mode, the LRE port LEDs show the LRE link status between the L RE switch and the connected
CPE device. To display additional information about the L RE links, use the Port Settings window or the
show controllersireprivileged EXEC commands. This mode does not apply to the 10/100 switch ports,
which continue to show Ethernet link status as described in Table 2-7.
Cyan (off) No LRE link present on the L RE port.
Green LRE link present on the LRE port. Port LED turns green in approximately 10 seconds
after the LRE port detects a connection to a CPE device.
Amber Switch LRE port and CPE RJ-11 wall port unable to establish the rate defined by the
assigned profile.
STAT Note  STAT mode on the LRE switch shows the status of the CPE Ethernet link between a Cisco 575 LRE
CPE and aremote Ethernet device, such asaPC. Thismode does not apply to connected Cisco 585 LRE
CPEs.? This mode is different for the switch 10/100 ports, as described in Table 2-7.
Cyan (off) No link present on the CPE Ethernet port.
Green CPE Ethernet link present between the CPE Ethernet port and the remote Ethernet
device. CPE Ethernet port isin STP forwarding state.
Amber Link fault. Error frames can affect connectivity, and errors such as excessive collisions,
CRC errors, and alignment and jabber errors are monitored for a link-fault indication.
CPE Ethernet port is not forwarding. Port was disabled by management, by an address
violation, or was blocked by STP.
Note  After a port isreconfigured, the port LED can remain amber for up to
30 seconds as STP checks the switch for possible loops.
Brown No link, and the CPE Ethernet port is administratively shut down.?
DUPLX Note DUPLX mode on the L RE switch showsthe duplex mode of the Ethernet port on aCisco 575 LRE CPE.
This mode does not apply to Cisco 585 L RE CPEs.? This mode s different for the switch 10/100 ports,
as described in Table 2-7.
Cyan (off) CPE Ethernet port is operating in half-duplex mode.
Green CPE Ethernet port is operating in full-duplex mode.
SPEED Note  SPEED mode on the LRE switch shows the speed of the Ethernet port on a Cisco 575 LRE CPE. This

mode does not apply to Cisco 585 L RE CPEs.? This mode does not show the LRE link speed, which is
displayed from the Port Settings window or show controllersIre privileged EXEC commands. This
mode is different for the switch 10/100 ports, as described in Table 2-7.

Cyan (off) CPE Ethernet port is operating at 10 Mbps.

Green CPE Ethernet port is operating at 100 Mbps.

1. Thistable describes the LRE port LEDs. See Table 2-7 for information on the 10/100 port LEDs on the L RE switch.

2. The LRE switch does not show the CPE Ethernet link status, duplex, or speed of the Ethernet ports on the Cisco 585 LRE CPEs. The LEDs for the switch
L RE ports connected to these CPE devices are cyan in thismode. To display the status of these CPE devices, use the show remote inter faces status user
EXEC command.

i Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
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Table 2-9  Port LEDs on the Catalyst 3500 XL Switches
Port Mode Port LED Color |Description
STATUS Cyan (off) No link.
Green Link present.
Amber Link fault. Error frames can affect connectivity, and errors such as excessive
collisions, CRC errors, and alignment and jabber errors are monitored for a
link-fault indication.
Port isnot forwarding. Port was disabled by management, by an address violation,
or was blocked by STP.
Note  After aport isreconfigured, the port LED can remain amber for up to 30
seconds as STP checks the switch for possible loops.
Brown No link and port is administratively shut down.
DUPLEX Cyan (off) Port is operating in half-duplex mode.
Green Port is operating in full-duplex mode.
SPEED 10/100 Ports
Cyan (off) Port is operating at 10 Mbps.
Green Port is operating at 100 Mbps.
1000BASE-X Ports
Cyan (off) Port is not operating.
Green Port is operating at 1000 Mbps.
LINE PWR Cyan (off) Inline power is off.
(C;’;\tajyst 3524-PWR XL | Green Inline power is on.
onty) If the Cisco IP Phone or Cisco access point isreceiving power from an AC power
source, the port LED is off even if the IP phone is connected to the switch port.
The LED turns green only when the switch port is providing power.

[ 78-6511-09
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VLAN Membership Modes

Portsin the Front Panel view are outlined by colors (Table 2-10) when you click Highlight VL AN Port
Member ship M odes on the Configure VLANS tab on the VLAN window

(VLAN >VLAN > Configure VLANS). The colors show the VLAN membership mode of each port.
The VLAN membership mode determines the kind of traffic the port carries and the number of VLANS
it can belong to. For more information about these modes, see the “Assigning VLAN Port Membership
Modes” section on page 9-5.

Note  Thisfeatureis not supported on the Catalyst 1900 and Catalyst 2820 switches.

Table 2-10 VLAN Membership Modes

Mode Color
Static access Light green
Dynamic access Pink

ISL trunk Orange
Multi-VLAN Yellow
802.1Q trunk Peach
ATM trunk Purple

Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
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Topology View

Note

The Topology view displays how the devices within a switch cluster are connected and how the switch
cluster is connected to other clusters and devices. From this view, you can add and remove cluster
members. This view provides two levels of detail of the network topology:

» When you right-click a cluster icon and select Expand Cluster, the Topology view displays the
switch cluster in detail. This view shows the command switch and member switchesin a cluster. It
al so shows candidate switches that can join the cluster. Thisview does not display the details of any
neighboring switch clusters (Figure 2-6).

» When you right-click a command-switch icon and select Collapse Cluster, the cluster is collapsed
and represented by a single icon. The view shows how the cluster is connected to other clusters,
candidate switches, and devices that are not eligible to join the cluster (such as routers, access
points, 1P phones, and so on) (Figure 2-7).

The Topology view displays only the switch cluster and network neighborhood of the specific command
or member switch that you access. To display adifferent switch cluster, you need to access the command
switch or member switch of that cluster.

You can arrange the device iconsin this view. To move adevice icon, click and drag the icon. To select
multiple device icons, you can either:

» Pressthe left mouse button, drag the pointer over the group of device icons that you want to select,
and then release the mouse button.

» Pressthe Ctrl key, and click the device icons that you want to select.
After selecting the icons, drag the iconsto any areain the view.

[ 78-6511-09
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Figure 2-6  Expand Cluster View
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Figure 2-7  Collapse Cluster View
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Topology Icons

The Topology view and the cluster tree use the same set of device icons to represent clusters, command
and standby command switches, and member switches (Figure 2-8). The Topology view also uses
additional icons to represent these types of neighboring devices:

» Customer premises equipment (CPE) devices that are connected to Long-Reach Ethernet (L RE)
switches

« Devicesthat are not eligible to join the cluster, such as Cisco IP phones, Cisco access points, and
Cisco Discovery Protocol (CDP)-capable hubs and routers

» Devicesthat are identified as unknown devices, such as some Cisco devices and third-party devices

Candidate switches are distinguished by the color of their device label. Device labels and their colorsare
described in the “ Colors in the Topology View” section on page 2-17.

The System Switch Processor (SSP) card in the Cisco Integrated Communications System (ICS) 7750
appears as a Layer 2 switch. SSP cards are not eligible to join switch clusters.

Neighboring devices are only displayed if they are connected to cluster members. To display neighboring
devices in the Topology view, either add the switch to which they are connected to a cluster, or enable
that switch as a command switch.

To select adevice, click theicon. Theicon isthen highlighted. To select multiple devices, you can either:

» Presstheleft mouse button, drag the pointer over the group of iconsthat you want to select, and then
release the mouse button.
» Pressthe Ctrl key, and click the icons that you want to select.

Figure 2-8 Topology-View Device Icons

Unknown

g’ Layer 2 Command Switch

::’ Layer 2 Member

::ﬂ Layer 2 Standby Command Switch j Layer 3 Standby Command

Layer 3 Command Switch LRE Camrmand Switch

Qdd

Layer 3 Member LRE Memher

LRE Standhy Command Switch

=l

Switch
o4 1-Port CPE Ct 0 4-Paort CPE
ﬂ___// IF Phone J—) Access Paint
i/ CDP-Capable Hub ) Router 2
[

[ 78-6511-09

Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide



Chapter 2 Getting Started with CMS |

M Topology View

The Topology view also uses a set of link icons (Figure 2-9) to show the link type and status between
two devices. To select alink, click thelink that you want to select. To select multiple links, press the Ctrl
key, and click the links that you want to select.

Figure 2-9 Topology-View Link Icons
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Device and Link Labels

The Topology view displays device and link information by using these labels:

Cluster and switch names
Switch MAC and | P addresses
Link type between the devices

Link speed and IDs of the interfaces on both ends of the link

When using these labels, keep these considerations in mind:

The IP address displays only in the labels for the command switch and member switches.

The label of a neighboring cluster icon only displays the IP address of the command-switch IP
address.

The displayed link speeds are the actual link speeds except on the LRE links, which display the
administratively assigned speed settings.

You can change the label settings from the Topology Options window, which is displayed by selecting
View > Topology Options.

Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
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Colors in the Topology View

The colors of the Topology view icons show the status of the devices and links (Table 2-11, Table 2-12,
and Table 2-13).

Table 2-11 Device Icon Colors

Icon Color |Color Meaning

Green The device is operating.

Yellow?! The internal fan of the switch is not operating, or the switch is receiving power from an
RPS.

Red! The device is not operating.

1. Available only on the cluster members.

Table 2-12 Single Link Icon Colors

Link Color |Color Meaning
Green Active link
Red Down or blocked link

Table 2-13 Multiple Link Icon Colors

Link Color

Color Meaning

Both green

All links are active.

Onegreen; onered [Onelink is active, and at least one link is down or blocked.

Both red

All links are down or blocked.

The color of adevice label shows the cluster membership of the device (Table 2-14).

Table 2-14 Device Label Colors

Label

Color Color Meaning

Green A cluster member, either a member switch or the command switch
Cyan A candidate switch that is eligible to join the cluster

Yellow An unknown device or adevicethat isnot eligibleto join the cluster

Topology Display Options

You can set the type of information displayed in the Topology view by changing the settings in the
Topology Options window. To display this window, select View > Topology Options. From this
window, you can select:

» Deviceiconsto be displayed in the Topology view

» Labelsto be displayed with the device and link icons

[ 78-6511-09
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Menus and Toolbar

The configuration and monitoring options for configuring switches and switch clusters are available
from menus and a toolbar.

Menu Bar

The menu bar provides the complete list of options for managing a single switch and switch cluster. The
menu bar is the same whether or not the Front-Panel or Topology views are displayed.

Options displayed from the menu bar can vary:

» Access modes affect the availability of featuresfrom CMS. The footnotesin Table 2-15 describe the
availability of an option based on your access mode in CMS: read-only (access level 1-14) and
read-write (access level 15). For more information about how access modes affect CM S, see the
“Access Modesin CMS” section on page 2-33.

« The option for enabling a command switch is only available from a CM S session launched from a
command-capable switch.

» Cluster management tasks, such as upgrading the software of groups of switches, are available only
from a CM S session launched from a command switch.

« If youlaunch CM S from a specific switch, the menu bar displays the features supported only by that
switch.

« If you launch CM S from a command switch, the menu bar displays the features supported on the
switches in the cluster, with these exceptions:

— If the command switch is a Layer 3 switch, such as a Catalyst 3550 switch, the menu bar
displays the features of all Layer 3 and Layer 2 switches in the cluster.

— If thecommand switchisaLayer 2 switch, such asa Catalyst 2950 or Catalyst 3500 XL switch,
the menu bar displays the features of all Layer 2 switchesin the cluster. The menu bar does not
display Layer 3 features even if the cluster has Catalyst 3550 Layer 3 member switches.
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S
Note « We strongly recommend that the highest-end, command-capable switch in the cluster be the
command switch:
— If your switch cluster has a Catalyst 3550 switch, that switch should be the command switch.

— If your switch cluster has Catalyst 2900 XL, Catalyst 2950, and Catalyst 3500 XL switches, the
Catalyst 2950 should be the command switch.

— If your switch cluster has Catalyst 1900, Catalyst 2820, Catalyst 2900 XL, and
Catalyst 3500 XL switches, either the Catalyst 2900 XL or Catalyst 3500 XL should be the
command switch.

- Standby command switches must meet these requirements:

— When the command switch is a Catalyst 3550 switch, all standby command switches must be
Catalyst 3550 switches.

— When the command switch is a Catalyst 2950 switch running Release 12.1(9)EA1 or later, all
standby command switches must be Catalyst 2950 switches running Release 12.1(9)EA1 or
later.

— When the command switch is a Catalyst 2950 switch running Release 12.1(6)EA2 or later, all
standby command switches must be Catalyst 2950 switches running Release 12.1(6)EA2 or
later.

—  When the command switch is running Release 12.0(5)WC2 or earlier, the standby command
switches can be these switches: Catalyst 2900 XL, Catalyst 2950, and Catalyst 3500 XL
switches.

We strongly recommend that the command switch and standby command switches are of the same
switch platform.

— If you have a Catalyst 3550 command switch, the standby command switches should be
Catalyst 3550 switches.

— If you have a Catalyst 2950 command switch, the standby command switches should be
Catalyst 2950 switches.

— If you have a Catalyst 2900 XL or Catalyst 3500 XL command switch, the standby command
switches should be Catalyst 2900 XL and Catalyst 3500 XL switches.

Refer to therelease notes (http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900xI/index.htm) for
the Catalyst switches that can be part of a switch cluster.

Note  Unless noted otherwise, Table 2-15 lists the menu-bar options available from a Catalyst 2900 XL or
Catalyst 3500 XL command switch and when the cluster contains only Catalyst 2900 XL and
Catalyst 3500 XL member switches. The menu bar of the command switch displaysall menu-bar options
available from the cluster, including options from member switches from other cluster-capable switch
platforms.

[ 78-6511-09
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Table 2-15 Menu Bar

Menu-Bar Options Task

CMS
Page Setup Set default document printer properties to be used when printing from CMS.
Print Preview View the way the CM S window or help file will appear when printed.
Print Print a CM S window or help file.

Guide Mode/Expert Mode!

Select which interaction mode to use when you select a configuration option.

Preferences?

Set CM Sdisplay properties, such aspolling intervals, the default viewsto open at startup,
and the color of administratively shutdown ports.

Administration

|P Addresses® Configure IP information for a switch.

SNMP? Enable and disable Simple Network Management Protocol (SNMP), enter community
strings, and configure end stations as trap managers.

System Time? Configure the system time or configure the Network Time Protocol (NTP).

Console Baud Rate? Change the baud rate for the switch console port.

MAC Addresses’ Enter dynamic, secure, and static addresses in aswitch addresstable. You can also define
the forwarding behavior of static addresses.

ARP? Display the device Address Resolution Protocol (ARP) table, and configure the ARP

cache timeout setting.

Save Configuration®

Save the configuration for the cluster or switch to Flash memory.

Restore Configuration®

Restore the configuration for the cluster or switch from Flash memory.

Software Upgrade* Upgrade the software for the cluster or a switch.

L RE Software Upgrade Upgrade the binary on the switch.

System Reload* Reboot the switch with the latest installed software.
Cluster

Cluster Manager®

Launch a CM S session from the command switch.

Create Cluster® 4

Designate a command switch, and name a cluster.

Delete Clustert ®

Delete a cluster.

Add to Cluster® ®

Add a candidate to a cluster.

Remove from Cluster! ®

Remove a member from the cluster.

Standby Command Switches? ®

Create a Hot Standby Router Protocol (HSRP) standby group to provide
command-switch redundancy.

Hop Count? ®

Enter the number of hops away that a command switch looks for members and for
candidate switches.

Device

Device Manager®

Launch Device Manager for a specific switch.

Host Name! Change the host name of a switch.
STP? Display and configure STP parameters for a switch.
CGMP? Enable and disable the CGM P and the CGMP Fast Leave feature on a switch.
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Menu-Bar Options

Task

LRE Profiles

Display the LRE profile settings for the Catalyst L RE switches, and configure the speed
of the LRE link.

LRE Rate Selection

Set rate selection parameters for automatically assigning profiles, setting signal-to-noise
(SNR) margins, locking profiles, and qualifying links.

Voice Wizards!

Voice Wizard'—Configure a port to forward voice traffic with an 802.1P priority and to
configure the port as an 802.1Q trunk and as a member of the voice VLAN (VVID).

Port
Port Settings? Display and configure port parameters on a switch.
Port Search Search for a port through its description.
Port Security? Enable port security on a port.
EtherChannels® Group portsinto logical units for high-speed links between switches.
SPAN? Enable Switch Port Analyzer (SPAN) port monitoring.

Protected Port?

Configure a port to prevent it from receiving bridged traffic from another port on the
same switch.

Flooding Control?

Block the normal flooding of unicast and multicast packets, and enable the switch to
block packet storms.

VLAN

VLAN?
(guide mode available?)

Display VLAN membership, assign portsto VLANS, and configure Inter-Switch Link
(ISL) and 802.1Q trunks. Display and configure the VLAN Trunking Protocol (VTP) for
interswitch VLAN membership.

Management VLAN? Change the management VLAN on the switch.
VMPS? Configure the VLAN Membership Policy Server (VMPS).
Voice VLAN? Configure aport to use avoice VLAN for voice traffic, separating it from the VLANsfor
(guide mode available) data traffic.
Reports
Inventory Display the device type, software version, IP address, and other information about a
switch.
Port Statistics Display port statistics.
Bandwidth Graphs Display graphs that plot the total bandwidth in use by the switch.
Link Graphs Display a graph showing the bandwidth being used for the selected link.

Link Reports®

Display the link report for two connected devices. If one device is an unknown device or
a candidate, only the cluster-member side of the link displays.

[ 78-6511-09
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Table 2-15 Menu Bar (continued)

Menu-Bar Options Task
View
Refresh Update the views with the latest status.

Front Panel

Display the Front Panel view.

Arrange Front Panel® ®

Rearrange the order in which switches appear in the Front Panel view.

Topology®

Display the Topology view.

Topology Options ®

Select the information to be displayed in the Topology view.

Automatic Topology Layout®

Request CM S to rearrange the topology layout.

Save Topology Layout? ®

Savethe presentation of the cluster iconsthat you arranged in the Topology view to Flash
memory.

Window List the open windows in your CM S session.
Help
Overview Obtain an overview of the CMS interface.
What's New Obtain a description of the new CMS features.

Help For Active Window

Display the help for the active open window. Thisisthe same as clicking Help from the
active window.

Contents List al of the available online help topics.
Legend Display the legend that describes the icons, labels, and links.
About Display the CM S version number.

1. Not availablein read-only mode. For more information about the read-only and read-write access modes, see the “Access Modesin CMS’ section on

page 2-33.

g M w DN

Some options from this menu option are not available in read-only mode.

Available only from a Device Manager session on a cluster member.

Available only from a Device Manager session on a command-capable switch that is not a cluster member.
Available only from a cluster management session.
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Toolbar

The toolbar buttons display commonly used switch and cluster configuration options and information
windows such aslegends and online hel p. Hover the cursor over anicon to display the feature. Table 2-16
describes the toolbar options, from left to right on the toolbar.

Table 2-16 Toolbar Buttons

Keyboard

Toolbar Option Shortcut  |Task

Print Ctrl-P Print a CM S window or help file.

Preferences! Ctrl-R Set CM S display properties, such as polling intervals, the viewsto open at CMS
startup, and the color of administratively shutdown ports.

Save Configuration? Ctrl-S Save the configuration for the cluster or switch to Flash memory.

Software Upgrade? Ctrl-U Upgrade the software for the cluster or a switch.

Port Settings! - Display and configure port parameters on a switch.

VLAN? - Display VLAN membership, assign portsto VLANS, and configure ISL and
802.1Q trunks.

Inventory - Display the device type, the software version, the | P address, and other
information about a switch.

Refresh - Update the views with the latest status.

Front Panel - Display the Front Panel view.

Topology?® - Display the Topology view.

Topology Options® - Select the information to be displayed in the Topology view.

Save Topology Layout?® |- Savethe presentation of the cluster iconsthat you arranged in the Topology view
to Flash memory.

Legend - Display the legend that describes the icons, labels, and links.

Help For Active Window |F1 key Display the help for the active open window. Thisis the same as clicking Help
from the active window.

1. Some options from this menu option are not available in read-only mode.

2. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “Access Modesin CMS” section
on page 2-33.

3. Available only from a cluster-management session.
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Front Panel View Popup Menus

These popup menus are available in the Front Panel view.

Device Popup Menu

You can display all switch and cluster configuration windows from the menu bar, or you can display
commonly used configuration windows from the device popup menu (Table 2-17). To display the device
popup menu, click the switch icon from the cluster tree or the front-panel image itself, and right-click.

Table 2-17 Device Popup Menu

Popup Menu Option Task
Device Manager? Launch Device Manager for the switch.
Delete Cluster? 3 4 Delete a cluster.

Remove from Cluster® 4 Remove a member from the cluster.

Bandwidth Graphs Display graphs that plot the total bandwidth in use.
Host Name* Change the name of the switch.
Properties Display information about the device and port on either end of thelink and

the state of the link.

Available from a cluster member switch but not from the command switch.
Available only from the command switch.
Available only from a cluster-management session.

Eal R I o

Not available in read-only mode. For more information about the read-only and read-write access modes, see the “ Access
Modesin CMS” section on page 2-33.

Port Popup Menu

You can display all port configuration windows from the Port menu on the menu bar, or you can display
commonly used port configuration windows from the port popup menu (Table 2-18). To display the port
popup menu, click a specific port image, and right-click.

Table 2-18 Port Popup Menu

Popup Menu Option  |Task

Port Settings! Display and configure port settings.

VLAN? Define the VLAN mode for a port or ports and add ports to VLANSs. Not
available for the Catalyst 1900 and Catalyst 2820 switches.

Port Security! 2 Enable port security on a port.

Link Graphs® Display a graph showing the bandwidth used by the selected link.

Select All Ports Select all ports on the switch for global configuration.

1. Some options from this menu option are not available in read-only mode.
2. Available on switches that support the Port Security feature.

3. Available only when thereis an active link on the port (that is, the port LED is green when in port status mode).
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Topology View Popup Menus

These popup menus are available in the Topology view.

Link Popup Menu

You can display reports and graphs for a specific link displayed in the Topology view (Table 2-19). To
display the link popup menu, click the link icon, and right-click.

Table 2-19 Link Popup Menu

Popup Menu Option  |Task

Link Report Display the link report for two connected devices. If one device is an unknown
device or a candidate, only the cluster member side of the link displays.

Link Graph Display a graph showing the bandwidth used by the selected link.

Properties Display information about the device and port on either end of the link and the
state of the link.

The Link Report and Link Graph options are not available if at both ends of the link are
- Candidate switches
- Catalyst 1900 and Catalyst 2820 switches
» Devicesthat are not eligible to join the cluster

If multiple links are configured between two devices, when you click the link icon and right-click, the
Multilink Content window appears (Figure 2-10). Click the link icon in this window, and right-click to
display the link popup menu specific for that link.

Figure 2-10 Multilink Decomposer Window
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Device Popup Menus

Specific devices in the Topology view display a specific popup menu:
» Cluster (Table 2-20)
» Command switch (Table 2-21)
« Member or standby command switch (Table 2-22)
» Candidate switch with an IP address (Table 2-23)
» Candidate switch without an IP address (Table 2-24)
= Neighboring devices (Table 2-25)

Note  The Device Manager option in these popup menus is available in read-only mode on Catalyst 2900 XL
and Catalyst 3500 XL switches running Release 12.0(5)WC2 and later. It is also available on
Catalyst 2950 switches running Release 12.1(6)EA2 and later and on Catalyst 3550 switch running
Release 12.1(8)EA1 or later. It is not available on the Catalyst 1900 and Catalyst 2820 switches.

To display a device popup menu, click an icon, and right-click.

Table 2-20 Device Popup Menu of a Cluster Icon

Popup Menu Option Task

Expand cluster View a cluster-specific topology view.

Properties Display information about the device and port on either end of the link and the
state of the link.

Table 2-21 Device Popup Menu of a Command-Switch Icon

Popup Menu Option  |Task

Collapse cluster View the neighborhood outside a specific cluster.

Host Name* Change the host name of a switch.

Bandwidth Graphs Display graphs that plot the total bandwidth in use by the switch.

Properties Display information about the device and port on either end of the link and the
state of the link.

1. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “ Access
Modesin CMS” section on page 2-33.

Table 2-22 Device Popup Menu of a Member or Standby Command-Switch Icon

Popup Menu Option Task

Remove from Cluster! Remove a member from the cluster.
Host Name* Change the host name of a switch.
Device Manager? Launch Device Manager for a switch.
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Table 2-22 Device Popup Menu of a Member or Standby Command-Switch Icon (continued)

Popup Menu Option

Task

Bandwidth Graphs

Display graphs that plot the total bandwidth in use by the switch.

Properties

Display information about the device and port on either end of the link and
the state of the link.

1. Available only from a cluster-management session.

2. Available from a cluster member switch but not from the command switch.

Table 2-23 Device Popup Menu of a Candidate-Switch Icon (When the Candidate Switch Has an
IP Address)

Popup Menu Option

Task

Add to Cluster®

Add a candidate to a cluster.

Device Manager?

Launch Device Manager for a switch.

Properties

Display information about the device and port on either end of the link and the
state of the link.

1. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “Access
Modesin CMS” section on page 2-33.

2. Available from a cluster member switch but not from the command switch.

Table 2-24 Device Popup Menu of a Candidate-Switch Icon (When the Candidate Switch Does Not
Have an IP Address)

Popup Menu Option Task
Add to Cluster! Add a candidate to a cluster.
Properties

Display information about the device and port on either end of thelink and the
state of the link.

1. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “ Access
Modesin CMS” section on page 2-33.

Table 2-25 Device Popup Menu of a Neighboring-Device Icon

Popup Menu Option

Task

Device Manager!

Access the web management interface of the device.

Note  Thisoption is available on Cisco access points, but not on Cisco IP
phones, hubs, routers and on unknown devices such as some Cisco
devices and third-party devices.

Disqualification Code

Display the reason why the device could not join the cluster.

Properties

Display information about the device and port on either end of the link and
the state of the link.

1. Available from acluster member switch but not from the command switch.
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Interaction Modes

You can change the interaction mode of CMS to either guide or expert mode. Guide mode steps you
through each feature option and provides information about the parameter. Expert mode displays a
configuration window in which you configure the feature options.

Guide Mode
~

Note  Guide mode is not available if your switch access level isread-only. For more information about the
read-only access mode, see the “Access Modesin CM S’ section on page 2-33.

Guide mode is for users who want a step-by-step approach for completing a specific configuration task.
Thismodeis not available for all features. A menu-bar option that has a person icon means that guide
mode is available for that option.

When you click Guide M ode and then select amenu-bar option that supports guide mode, CM S displays
a specific parameter of the feature with information about the parameter field. To configure the feature,
you provide the information that CM S requests in each step until you click Finish in the last step.
Clicking Cancel at any time closes and ends the configuration task without applying any changes.

If Expert Modeis selected and you want to use guide mode, you must click Guide M ode before
selecting an option from the menu bar, tool bar, or popup menu. If you change the interaction mode after
selecting a configuration option, the mode change does not take effect until you select another
configuration option.

Expert Mode

Expert mode is for users who prefer to display all the parameter fields of afeaturein asingle CMS
window. Information about the parameter fields are provided from Help.

Wizards
~

Note  Wizards are not available if your switch access level is read-only. For more information about the
read-only access mode, see the “Access Modesin CMS” section on page 2-33.

Wizards simplify some configuration tasks on the switch. Similar to the guide mode, wizards provide a
step-by-step approach for completing a specific configuration task. Unlike guide mode, a wizard does
not prompt you to provide information for all of the feature options. Instead, it prompts you to provide
minimal information and then uses the default settings of the remaining options to set up default
configurations.

Wizards are not available for all features. A menu-bar option that has wizard means that selecting that
option launches the wizard for that feature.
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Tool Tips

CMS displays a popup message when you move your mouse over these devices:

» A yellow deviceicon in the cluster tree or in Topology viewv—A popup displays a fault message,
such as that the RPS is faulty or that the switch is unavail able because you are in read-only mode.

« A red deviceicon in the cluster tree or in Topology view—A popup displays a message that the
switch is down.

If you move your mouse over atable column heading, a popup displays the full heading.

Online Help

CMS provides comprehensive online help to assist you in understanding and performing configuration
and monitoring tasks from the CM S windows (Figure 2-11).

- Feature help, available from the menu bar by selecting Help > Contents, provides background
information and concepts on the features.

- Dialog-specific help, available from Help on the CM S windows, provides procedures for
performing tasks.

» Index of help topics.
» Glossary of terms used in the online help.

You can send us feedback about the information provided in the online help. Click Feedback to display
an online form. After completing theform, click Submit to send your commentsto Cisco. We appreciate
and value your comments.

Figure 2-11 Help Contents and Index
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CMS Window Components

CMS windows consistently present configuration information. Figure 2-12 shows the components of a
typical CM S window.

Figure 2-12 CMS Window Components
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change settings.

information.

Host Name List

OK saves your changes and
closes the window.

— Modify displays a secondary
window from which you can

— Click a row to select it. Press Shift,
and left-click another row to select
contiguous multiple rows. Press Citrl,
and left-click rows to select non-
contiguous rows.

Click a tab to display more

Apply saves your changes and leaves J
the window open.

Refresh refreshes the window to display
the latest information.

Cancel closes the window without saving
the changes.

Help displays help for the window and the ———
menu of Help topics.

Select a cluster member from the
Host Name list to display its settings.

To display or change the configuration of a cluster member, you need to select the specific switch from
the Host Name drop-down list. The list appears in the configuration window of each feature and lists
only the cluster members that support that feature. For example, the Host Name list on the VLAN
window does not include Catalyst 1900 and Catalyst 2820 switches even though they are part of the
cluster. Similarly, the Host Name list on the L RE Profiles window only lists the LRE switchesin the
cluster.
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Tabs, Lists, and Tables

Some CM S windows have tabs that present different sets of information. Tabs are arranged like folder
headings across the top of the window. Click the tab to display its information.

Listed information can often be changed by selecting an item from alist. To change the information,
select one or moreitems, and click M odify. Changing multipleitemsislimited to those items that apply
to at least one of the selections.

Some CM S windows present information in atable format. You can edit the information in these tables.

Note  You can resize the width of the columns to display the column headings, or you can hover your cursor
over the heading to display a popup description of the column.

Filter Editor

When you click Filter in a CMS window that has atable, the Filter Editor window appears. The column
names in the table become the field names in this window. You can enter selection criteriain these field

names to filter out table rowsthat you do not want to see. For procedures on using the Filter Editor, refer
to the online help.

Icons Used in Windows

Some window have icons for sorting information in tables, for showing which cellsin atable are
editable, and for displaying further information from Cisco.com (Figure 2-13).

Figure 2-13 Window Icons
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Buttons

These are the most common buttons that you use to change the information in a CM S window:

» OK—Save any changes and close the window. If you made no changes, the window closes. If CMS
detects errorsin your entry, the window remains open. For more information about error detection,
see the “Error Checking” section on page 2-34.

- Apply—Save any changes made in the window and |eave the window open. If you made no changes,
the Apply button is disabled.

- Refresh—Update the CM S window with the latest status of the device. Unsaved changes are lost.

» Cancel—Do not save any changes made in the window and close the window.
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» Help—Display procedures on performing tasks from the window.

- Modify—Display the secondary window for changing information on the selected item or items.
You usually select an item from alist or table and click M odify.

Accessing CMS

This section assumes the following:

» You know the | P address and password of the command switch or aspecific switch. Thisinformation
is either:

— Assigned to the switch by following the setup program, as described in the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900xI/index.htm).

— Changed on the switch by following the information in the “ Changing | P Information” section
on page 6-2 and “Assigning Passwords and Privilege Levels” section on page 6-11.
Considerations for assigning | P addresses and passwords to a command switch and cluster
members are described in the “|P Addresses’ section on page 5-15 and “ Passwords” section on
page 5-16.

« You know your access privilege level to the switch.

= You have referred to the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900xI/index.htm) for system requirements
and have followed the procedures for installing the required Java plug-ins and configuring your
browser.

A

Caution  Copiesof the CM S pagesyou display are saved in your browser memory cache until you exit the browser
session. A password is not required to redisplay these pages, including the Cisco Systems Access page.
You can accessthe CLI by clicking Web Console- HTML accessto the command lineinterface from
a cached copy of the Cisco Systems Access page. To prevent unauthorized accessto CMS and the CLI,
exit your browser to end the browser session.

Note  If you have configured the Terminal Access Controller Access Control System Plus (TACACS+) or
Remote Authentication Dial-In User Service (RADIUS) feature on the switch, you can still access the
switch through CMS. For information about how inconsistent authentication configurations in switch
clusters can affect access through CMS, see the “TACACS+ and RADIUS” section on page 5-17.

To access CMS, follow these steps:

Step1  Enter the switch IP address and your privilege level in the browser L ocation field (Netscape
Communicator) or Address field (Microsoft Internet Explorer). For example:

http://10.1.126.45:184/1level/14/

where 10.1.126.45 isthe switch IP address, 184 isthe HTTP port, and 1eve1/14 isthe privilege level.
You do not need to enter the HTTP port if the switch isusing HTTP port 80 (the default) or enter the
privilege level if you have read-write access to the switch (privilege level is 15). For information about
the HTTP port, seethe “HTTP Accessto CMS’ section on page 4-3. For information about privilege
levels, see the “Access Modesin CMS’ section on page 2-33.

Step2  When prompted for a username and password, enter only the switch enable password. CM S prompts you
a second time for a username and password. Enter only the enable password again.
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If you configure alocal username and password, make sure you enable it by using the ip http
authentication global configuration command. Enter your username and password when prompted.
Step3  Click Cluster Management Suite.

If you access CM S from a standal one or member switch, Device Manager appears. If you access CMS
from a command switch, you can display the Front Panel and Topology views.

Access Modes in CMS
CMS providestwo levels of access to the configuration options:. read-write access and read-only access.
Privilege levels 0 to 15 are supported.

« Privilege level 15 provides you with read-write access to CMS.

« Privilege levels 1 to 14 provide you with read-only access to CMS. Any optionsin the CMS
windows, menu bar, toolbar, and popup menus that change the switch or cluster configuration are
not shown in read-only mode.

- Privilege level O denies accessto CMS.

If you do not include a privilege level when you access CMS, the switch verifies if you have
privilege-level 15. If you do not, you are denied access to CMS. If you do have privilege-level 15, you
are granted read-write access. Therefore, you do not need to include the privilege level if it is 15.
Entering zero denies access to CMS. For more information about privilege levels, see the “Assigning
Passwords and Privilege Levels” section on page 6-11.
S
Note « If your cluster has these member switches running earlier software releases and if you have
read-only access to these member switches, some configuration windows for those switches display
incomplete information;
— Catalyst 2900 XL or Catalyst 3500 XL member switches running Release 12.0(5)WC2 or
earlier
— Catalyst 2950 member switches running Release 12.0(5)WC2 or earlier
— Catalyst 3550 member switches running Release 12.1(6)EA1 or earlier
For more information about this limitation, refer to the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900xI/index.htm).
» These switches do not support read-only mode on CMS;
— Catalyst 1900 and Catalyst 2820
— Catalyst 2900 XL switches with 4-MB CPU DRAM
In read-only mode, these switches appear as unavailable devices and cannot be configured from
CMS.
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Verifying Your Changes

CMS provides notification cues to help you track and confirm the changes you make.

Change Notification

A green border around afield or table cell means that you made an unsaved change to the field or table
cell. Previousinformationin that field or table cell isdisplayed in the window status bar. When you save
the changes or if you cancel the change, the green border disappears.

Error Checking

A red border around a field means that you entered invalid datain the field. An error message also
displaysin the window status bar. When you enter valid datain the field, a green border replaces the red
border until you either save or cancel the change.

If thereisan error in communicating with the switch or if you make an error while performing an action,
a popup dialog notifies you about the error.

Saving Your Changes
~

Note  The Save Configuration option is not available if your switch access level is read-only. For more
information about the read-only access mode, see the “Access Modesin CMS” section on page 2-33.

L

Tip As you make cluster configuration changes (except for changes to the Topology view and in the
Preferences window), make sure that you periodically save the configuration from the command switch.
The configuration is saved on the command and member switches.

The front-panel images and CM S windows always display the running configuration of the switch.
When you make a configuration change to a switch or switch cluster, the change becomes part of the
running configuration. The change does not automatically become part of the config.txt file in Flash
memory, which is the startup configuration used each time the switch restarts. If you do not save your
changes to Flash memory, they are lost when the switch restarts.

To save all configuration changes to Flash memory, you must select Administration > Save
Configuration.

Note  Catalyst 1900 and Catalyst 2820 switches automatically save configuration changesto Flash memory as
they occur.
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Using Different Versions of CMS

When managing switch clusters through CMS, remember that clusters can have a mix of switch models
using different |OS releases and that CM Sin earlier |OSrel eases and on different switch platforms might
look and function differently from CMSin this 10S release.

When you select Device > Device Manager for a cluster member, a new browser session is launched,
and the CM S version for that switch is displayed.

Here are examples of how CMS can differ between |OS releases and switch platforms:

« On Catalyst switches running Release 12.0(5)WC2 or earlier or Release 12.1(6)EA1 or earlier, the
CMS versions in those software rel eases might appear similar but are not the same as this release.
For example, the Topology view in thisreleaseis not the same as the Topology view or Cluster View
in those earlier software releases.

« CMSon the Catalyst 1900 and Catalyst 2820 switches is referred to as Swvitch Manager. Cluster
management options are not available on these switches. Thisis the earliest version of CMS.

Refer to the documentation specific to the switch and its | OS rel ease for descriptions of the CM Sversion
you are using.

Where to Go Next

Before configuring the switch, refer to these places for start-up information:

« Switch release notes on Cisco.com
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900xI/index.htm):

— CMS software requirements

Procedures for running the setup program

Procedures for browser configuration

Procedures for accessing CM S
» Chapter 4, “General Switch Administration”

Therest of thisguide providesinformation about and CL1 procedures for the software features supported
in this release. For CM S procedures and window descriptions, refer to the online help.
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